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Introduction 

SuperList is a hierarchical checklist program allowing for multiple sub-items and branch trees for efficient 
categorization. You can either import your list from a simple text file or create main and sub-item entries directly 
on the screen. If you decide later that you want to reposition the order of certain items on the screen, you can do 
so by a simple drag-n-drop procedure. The text colors, background images, display attributes, etc. are all 
customizable for each list you create. With SuperList you can easily switch between different lists in your main 
database, and you can also password-protect certain lists for security purposes. 

Installation 
 
SuperList is designed for the Pocket PC devices running the 2000, 2002, and 2003 OS Shell. This includes all 
devices using the WinCE 3.0 or 4.0 base OS. 
 
The installer program for SuperList is contained in the superlist.zip file, which you downloaded from either our 
web site (www.scarybearsoftware.com) or another online vendor’s site. Running the installer program called 
superlist_install.exe on your Desktop PC will install the necessary files on your Pocket PC device when you make a 
valid ActiveSync connection between your device and Desktop PC. A shortcut to the SuperList program can be 
found in the “Programs” screen on your device, labeled SuperList. 
 
For best performance, it is recommended that you install SuperList in main memory. You can install the 
application on an external CF or SD storage card, however, you may notice a performance degradation due to the 
reading from and writing to the slower storage media. 
 

Registration 
 
By default, SuperList will be installed as a trial version, which has all the functionality of the full version. The only 
limitation is that you can only create 2 lists and have a maximum of 10 entries each. With the full version, there is 
no limitation to the number of lists you can create and the maximum number of entries per list is 30,000. To 
permanently activate SuperList on your device, you’ll need to purchase the software to obtain a valid 12-digit reg 
key code number. Entering this code number in the “About…” screen of the program will convert the trial version 
of the software to the full version. 
 

http://www.scarybearsoftware.com/


Features 
 
Below is a general list of features for the SuperList: 
 

• Very easy to use  

• A hierarchical list program with branches for multiple sub-items 

• User-defined colors for text and background 

• Can select a custom background image for each list (in bmp, jpg, or gif format) 

• Can create multiple lists each with user-defined color properties 

• Can have checked items be colored a different color with strike-thru font 

• Can easily move items around on the list by drag-n-drop procedure 

• Can activate alphabetic and/or check sorting of the list  

• Can import items from a text file 

• Can export list items to a text file  

• Automatic backup and recovery of list database file  

• Can password-protect specific lists 

• Text notes can be attached to defined items in a list 

• Hardware buttons can be used to scroll through the list and check/uncheck items,and expand or collapse 
tree branches 

• Can cut/copy/paste list items 

• A “Find” feature is available for substring searches through the list 

 

 
 

 



Usage 
 
General 

When you first start SuperList, you will see a screen similar to Figure 1, which shows no lists in the main 
database.  

 
 

Figure 1 
SuperList main display 



Figure 2 identifies the menu bar icons, which you can tap to perform specific functions. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2 
Menu bar icons 



To create a new list, either tap on the “New List” menu bar icon or select “File->New List…” 
from the Menu Bar. You should see a popup DialogBox as shown in Figure 3 asking for a list name. 
Once you’ve created a list, you can begin to add entries by tapping on the “New Item” menu bar 
icon or by selecting “File->New Main Item” from the Menu Bar. You should see a small EditBox 
appear on the screen allowing you to type in text for the item label (Figure 4). 

  
    

 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
  
 

 Figure 3 Figure 4 
 Creating a new list Create a new item 
 
If you want to create a sub-item under the “Clothes” main item, you can do so by doing a tap-n-
hold with the stylus on the item “Clothes” on the screen to bring up the popup menu shown in 
Figure 5, and select “New Subitem”. Then enter the text for the sub-item as shown in Figure 6. 

 
  
 
 
 
 
 
 
 
 
 
                            
 
 
 
 
 
 
 
 
 

  Figure 5 Figure 6 
 Tap-n-Hold Stylus on Item Adding a Sub-Item 
 



You can continue with this procedure of adding main items or sub-items to your list. You can also create sub-
items from existing sub-items as shown in Figure 7 following these same procedures. If you need to edit the text 
of an item, simply double-tap on that item to bring up the EditBox as shown in Figure 8. 
 

   
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 7 Figure 8 
 Creating Sub-Items on Sub-Items Double-tap to edit an item 

To delete a specific item in the list, you can do a tap-n-hold on that item to bring up the popup menu bar (as 
shown in figure 5), and select “Delete” from the popup menu choices. 



SuperList also has the capability of attaching text notes to defined items in a list. Just do a tap-n-hold on an item 
in the list and select “Add Note…” from the popup menu (Figure 9), you will see a dialogBox as shown in Figure 
10 where you can enter text to be attached to that selected note. 

   

 

 

 

 

 

 

 

 

   

 Figure 9 Figure 10 
              Popup menu with Add Note Entering text for an attached note 

Now when you look at the main list you will see a small note icon to the right of the item’ check box, indicating 
that a note is attached. If you tap the yellow note icon in the main menu bar, you will see a small window appear 
at the bottom of the screen which will display the currently selected item’s attached note (Figure 11). 

To delete a note attached to a list item, just do another tap-n-
hold on the item with a note, and select “Modify Note…” from 
the pop-up menu to bring up the note edit dialogBox again, and 
then erase the text in the editbox and leave it blank. When you 
tap the OK button and return to the list, you’ll see that the note 
icon is now gone. 

 

 

 

 

 

 

  
                           Figure 11 
 Note icon and displayed Note Text



If you want to rearrange the order of items in a list, you can use your stylus to drag-n-drop a specific item from 
one location to another on the screen. Just hold the stylus down on the desired item, and then drag it on the 
screen to the new location. Figure 12 shows what the screen would look like if you were in the process of 
dragging the item “Dress Shoes” up above the item “Hiking Boots”. Note, to start the dragging process you will 
need to quickly drag the chosen item beyond it’s immediate location (either up or down). 

While dragging, the left end of the dragged image will change in appearance depending on its relative location to 
a target location. Figure 13 explains the different scenarios for the drop action and the associated drop graphic 
image. 

 

 

 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 Figure 12 
 Dragging an item on the screen 
 



 
 
 
 
 
 
 
 
 
 
                       
 
 
 
 
 
 
 
 
 
 Figure 13  
 Drag-n-Drop scenarios  
 
The dashed-line in front of the dragged item indicates that the item will be placed either before or after the 
target item it is hovering over (depending on if the stylus is above or below the target items centerline). The 
small box with a line in front of the dragged item indicates that the item will be dropped as a sub-item to the 
target item (as shown in Figure 13). There are no restrictions on where you can drag items on the screen to 
rearrange their display order. 
 
Tapping on the branch node button (the icon to the left of a parent item) will either expand or collapse a given 
branch of items. Figure 14 shows a branch expanded and collapsed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 14 
 Expanded and collapsed branch 
 



Tapping the “Find” icon in the menu bar will bring up the Find window as shown in Figure 15 below. In this 
window, you can type in a search substring and tap the “Next” button to have SuperList search out the current 
list and display a matching result on the screen (highlighted). Tapping the Find icon again in the menu bar will 
cause the Find window to be hidden again. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 15 
 Find Window for substring searches



Menu Bar Selections 
 
We’ll now go over the different selections from the menu bar. Figure 16 shows the available items under the File 
Menu. 

 
Selecting New List… does the same thing as tapping on the New 
List menu bar icon, and will display the DialogBox as shown in 
Figure 3 to create a new list. 
 
The Rename List… selection will allow you to rename a current 
list. 
 
The Delete List… selection will delete the currently displayed list. 
 
Selecting New Main Item… is the same as tapping on the New 
Item menu bar icon, and will create a new item in the current list. 
 
If you’ve highlighted an item in the list and tap the New Sub 
Item… selection, you can create a sub-item under the selected 
parent item. The highlighted item can be either a main item or a 
sub-item. 
 
Selecting an item on the screen and tapping the Delete Item will 
delete the selected item from the SuperList database. 
 

 Figure 16 
                      File Menu 
 
The Export List… function will allow you to export the current list to a simple text file on your system. Tapping 
this option will bring up a DialogBox as shown in Figure 17 below. Here, you can specify the export file name and 
in which folder to write the file. Similarly, you can select the Import List… option and import an item list from a 
simple text file into the current list in SuperList. The DialogBox for the import is shown in Figure 18. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 17 Figure 18 
 Export list DialogBox Import list DialogBox



The format of the text file for importing data into SuperList will be discussed later in this document. 
 
The next menu item is Edit, which allows you to cut, copy, or paste a selected item in the list. Note, this option 
will only allow you to do a cut/copy operation on the selected base item in a list, and won’t perform the cut/copy 
operation on the item’s children subitems. Also, the menu item will remain grayed out until you actually select an 
item in the list to copy or have a copied item in the memory buffer. 
 
The Options menu is used to change the different display options for the SuperList program. Under Font Size 
you can select the font size for the text drawn in a list on the screen (Figure 19). Under Sort you can specify 
whether you want the current list to be sorted alphabetically and/or by checked status (Figure 20).  
   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 19 Figure 20 
 Font size selection List sort order options 

  



Under the Checked menu item, you can quickly uncheck or check all items in the current list (Figure 21). The 
Hidden menu item allows you to flag all the items in list to be hidden or shown (Figure 22). These hidden items 
can be displayed using a specified color if the Hilite Hidden option is activated. Also, the Hide On/Hide Off 
option will allow you to either hide all entries marked hidden or show them. 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Figure 21 Figure 22 
 Check/Uncheck Operation Hidden Options 



The Expand menu item will allow you to expand or collapse all list branches (Figure 23). By selecting the Set 
Password… entry (Figure 24) you can assign a password to the current list. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 23 Figure 24 
 Expand Options Setting a password for the current list 
 
If later you would like to change the password for a list, you can do so by selecting Set Password… again 
which will show the DialogBox in Figure 25. Note, applying a password to a list won’t encrypt the list data. It will 
simply not display the list items if the user doesn’t enter the correct password when trying to access that 
particular list. 
 

Also, you can remove a password assigned to a list by entering 
the current password in the DialogBox shown in Figure 25, and 
then leaving the New Password EditBox blank. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 25   
 Changing a password for a list 
 
 



Selecting the Settings… menu item will display the SuperList configuration screen (Figure 26), where you can 
adjust colors, display appearance, etc. 
 
Under the Options tab screen, you can define whether you want to use a solid color background for the 
displayed list or a custom bitmap image. Figure 26 shows what you would see if you have Use solid color 
selected for the background settings. Here, you can tap on the colored box to the right of the Background 
Color to bring up the color picker control (Figure 27) to change the background color for the current list. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 Figure 26 Figure 27 
 Options tab screen Color picker control 

 
If you had selected Use bitmap image file for the background 
settings, you would see the screen shown in Figure 28 below. 
 
Here, you can select from available bitmap files found in the 
SuperList install folder. By tapping on any listed bitmap file, you w
see a preview in the small window to the right of the listed bitma
files. The default bitmap image is a “clouds” background. 

ill 
p 
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You can also change the color of the list name displayed at the top 
of the screen by tapping on the colored box to the right of the List 
Name Title Color label. The color picker control as shown in 
Figure 26 will appear, allowing you to select a new color. 
 
If you check the Backup database to “/My Documents” o
a copy of the SuperList database file will be copied to the “My 
Documents” folder on your device as a backup. If you have 
ActiveSync configured to sync all files in this folder, your SuperList 
database will be backed up to your Desktop PC. The usefulness of 
this feature will be discussed later in this document. 
 

                            Figure 28 
 Selecting bitmap background images 
 
Checking the Display delete warning message will cause SuperList to display a message box warning you 
whenever you try to delete an item from a list. 



 
Figure 29 shows the Display tab screen, where you can adjust different parameters for the list display 
appearance. The text color used for the different levels of branches can be defined here, by tapping on the 
colored box to bring up the color picker control.  
 

You can also define a color for the dashed lines connecting the 
different items on the screen under Line Color.  
 
The Button Icon allows you to define which icon graphic to use 
for the displayed list. To select an icon, just tap on either one. 
 
You can also specify if you want the main items to be displayed 
with a bold font (by checking Main Items), and if you want 
checked items to be displayed using a strike-thru font. Also with the 
checked items, you can have the text drawn using a defined color. 
 
Hidden Items allows you to define the color for items marked 
hidden in your list. 
 
The Auto check parent items option will cause SuperList to 
automatically check parent items if it’s sub-items are all checked 
off. Figure 30 illustrates how this would work. The parent item will 
also be unchecked if any of the sub-items to that parent are 
unchecked. 
 

 
 Figure 29 
 Display tab screen 
 
You also have the option of displaying or hiding the list’s checkboxes by checking the Draw Checkboxes option. 
If you deactivate this feature, then the “Checked Items” Strike-font and colored options will also be deactivated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 30 
 Illustration of the auto-check parent feature 
 
 



The last settings panel is called “Notes”, and it allows you to change some of the notes window properties (Figure 
31).  
 
Here, you can set the note window’s background color, text color, and text font size. You can also specify the 
height of the note window by defining the number of lines to be displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Figure 31 
 Notes Window Settings



List Password Protection 
 
As stated earlier, assigning a password to a specific list will prevent others from seeing those items in that list. 
The data in the list is not encrypted. So when you try to open a list that has an assigned password, you will see 
the screen shown in Figure 32. Tapping on the screen will bring up the Password DialogBox (Figure 33), where 
you will need to enter the correct password to view the list’s contents. 

   
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 32 Figure 33 
 Password protected screen Entering password to unlock list 

If you don’t enter a password, the only operations you can perform to the current list is to delete it. 
You can specify different passwords to different lists in your database. Also, if you forget a 
password for a list, there won’t be a way to unlock it. 
 

Hardware Key Functionality 
 
For one-handed operation, SuperList can respond to either the D-Pad hardware button (on the 
front of most Pocket PC devices) or the side scroll button. Using the hardware buttons can make it 
easier for you to scroll through a list and check items without the need of pulling out the stylus for 
screen tapping. 
 
Moving either of these buttons up or down will allow you to quickly change the currently selected 
item. By clicking either button, you can either check or uncheck a currently highlighted item. 
 
Also, clicking the D-Pad button to the left will collapse the sub-item branch for a highlighted parent 
item, and clicking the D-Pad button to the right will expand the branch. 
 



Recovering Data from Backup Database 

There may a situation when you may lose your SuperList database file (because you needed to do a hard-reset of 
your device, or your battery power completely drained for some reason). If you have the "Backup Database to 
\My Documents" checked in the Options panel (Figure 25), a copy of the SuperList database (superlist.vol) will 
be placed in the "\My Documents" folder on your Pocket PC device, which should be synced to your Desktop 
PC system's AutoSync folder. 

In the event of your Pocket PC device crashing or you having to do a hard-reset (which will erase all programs 
and data from your device), you'll need to reload the SuperList software on your Pocket PC device. If you want to 
recover the data stored in the backup copy of your SuperList database file, you should do the following: 

1. Establish a connection between your Pocket PC device and your Desktop PC system, and do a file sync. 
Make sure you have "Files" checked in the ActiveSync options panel.  
 

2. Install SuperList onto your device.  
 

3. Run SuperList on your device. The program should see that you don't have an existing database file on 
your device, and should then automatically check your "\My documents" folder for a copy of the 
database file. If it finds it, the program will show the following message box (Figure 34) asking if you 
want to recover from the backup copy. Selecting "Yes" will recover your SuperList data in the backup 
database file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 34 
Database recovery DialogBox 

 
 
 
 



Import List Format 

SuperList has the ability to import a list of items from a simple text file, which can make entering numerous list 
items very easy. You simply create a text file on your Desktop PC with each list item on a separate line, and then 
copy this text file over to your “/My Documents” folder for syncing with your Pocket PC device. Figure 35 
shows what a typical text file would look like in the NotePad application on a Desktop PC.  

You can also define sub-items in the text file by using Tab characters 
to define the different levels of sub-items. For example, lets say you 
have a main item called “Clothes” and under this item you have two 
sub-items called “Shirts” and “Pants”. The corresponding text file 
would look like what is shown in Figure 36, where you have one tab 
character before the Shirts and Pants line entry. 
 
 
 
 
 
 
 
 
                   Figure 36 
                   Text file with defined sub-items 
 
 

 Figure 35 
 Simple text file in NotePad 
 
You can use more than one tab character to defined different sub-item levels as well. For example, lets say you 
have the text defined in Figure 37, which after importing into SuperList would look like Figure 38. 

 

Figure 37
 
  Figure 38 

Text input file Imported list in SuperList 

If you want to define a note attached to an item, you simply 
 

 Figure 39

 
 
 

 

need to put another line after the item with a “~” character in
front of the note text (as shown in Figure 39). 
 
 

 

are must be taken when creating text files to ensure that the number of tabs used per line is valid for sub-item 
 
C
definition. If you have too many tabs in the wrong location of the text file, SuperList will abort the importing 
process. 
 
 



Another convenient way to generate lists for import into SuperList, is to use an MS-Excel which will automatically 
create tab characters for separating the different columns in your spreadsheet. For example, Figure 40 shows a 
simple list created in MS-Excel with different sub-item levels. 

 
The main item Clothes has sub-items of Shirt, 
Pants, Socks, Shoes, Ties, and Belt, while the 
item Shoes also has sub-items Dress Shoes and 
Sneakers. 
 
Now, if you save this spreadsheet as a “Tab 
Delimited Text” file as shown in Figure 41, the file 
will be saved in a text file format with the properly 
placed tabbed characters. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 40 
MS-Excel Spreadsheet layout  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 41 
MS-Excel “Save As” Tab delimited text file 



Now, if you copy the file you just created over to the “/My Documents” folder on your Pocket PC device, you can 
import the list into SuperList and it will look like what is shown in Figure 42. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 42 
Imported List 
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ou can export the current list into a text file by selecting Export List from the File Menu. The resultant text file 
ill have the same characteristics as described in the “Import List Format” section of this guide, containing tab 
aracters at appropriate locations to represent the sub-item levels. Attached notes are also exported. 
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Custom Background Image Format 
 
On the screen shown in Figure 25, the user can select from a list of custom background images. These images 

n be bitmap (.bmp), jpeg (.jpg), or gif (.gif) files stored in the SuperList install folder on your Pocket PC device. 
ese images will need to have a minimum size of 240 by 268 to sufficiently fill the background of the screen for 
perList. Larger images will be cropped appropriately. Simply create your background images using any paint 
ogram on your Desktop PC (e.g., Photoshop, PaintShop Pro, MS-Paint, etc.) and save it as a bmp, jpg, or gif 
e. Then, use File Explorer on your Desktop PC to copy the bitmap files over to your connected Pocket PC 
vice, into the SuperList install folder.  

 default, the install folder is: /Program Files/ScaryBear Software/SuperList 

u should find several sample image files already in the install folder, along with the superlist.exe executable file 
d superlist.vol database file. 

sing these bitmap background images can really enhance the graphical appearance of your displayed lists. Note, 
u can assign different background images (or solid color background) to each specific list. The figure below 
ows a few different background images with SuperList. New lists that are created will use the currently active 
ckground settings by default, and can be changed at any time. 

 
 

Different background images for SuperList 
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Possible Performance Issues 
 
Depending on your Pocket PC device model, SuperList may operate slower under certain conditions. For the 
fastest possible operation, it is recommended that you select the “Use Solid Color” background settings option 
(Figure 26). Using this option will maximize the speed in scrolling through the list and also for the drag-n-drop 
operations.  
 
Activating the “Use bitmap image file” will result in a slower response for scrolling and dragging since the
system must redraw the background ima

 
ge during these operations. For the newer faster Pocket PC devices, this 

ouldn’t be a problem. If you’re using SuperList on an older, slower device, you may see some significant 

e to the storage card. For best performance, install SuperList in the default 
cation (in main memory). 

n use the standard “Remove Programs” utility 
rovided on all Pocket PC devices. Once you go through the removal process, all files associated with SuperList 
ould be removed from your system. 

 
Final Comments 
 
Upgrades to SuperList are always free, and can be downloaded from our web site at 
www.scarybearsoftware.com

sh
slowness with the background bitmap feature activated. 
 
Also, installing SuperList on to an external CF or SD storage card may affect the performance of the application, 
since it must read from and writ
lo
 
Uninstallation 
 
If you have a need to uninstall SuperList from your system, you ca
p
sh

. Your existing valid 12-digit reg key code will also activate any future versions. If 
you’d like to be notified of future updates SuperList, you can join the ScaryBear Software News YahooGroups! 
From this link: http://www.scarybearsoftware.com/news.html 
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